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Bluefish444 AVID User guide 

Introduction 
Bluefish444 ‘The Professionals choice’ has partnered with AVID to bring true uncompressed 12-bit 

HD-SDI IO to users of AVID Media Composer 6.x, AVID Symphony 6.x, and AVID News Cutter 10.x 

onward. Bluefish444 SDI output is also supported from AVID Pro Tools 11 allowing Professional SDI 

video & audio preview directly from your AVID Pro Tools system. 

 Bluefish444 has been the choice of professionals requiring the highest quality HD-SDI input and 

output solutions. Supporting 4:2:2 YUV, 4:4:4 RGB, 3D, and 4K HD-SDI, with 12-bit video processing 

and the most accurate hardware scalers available in the market today.  

Bluefish444 have a long history of providing OEM solutions to industry leading developers requiring 

high quality IO solutions capable of performing day in day out all year around. The Create range of 

hardware caters to video professionals that require tried and tested reliability combined with the 

true uncompressed input and output solutions. Supporting SD/HD/2K/4K capture & playback, 12-bit 

video processing combined with hardware scaling and a quality HDMI video preview. Create cards 

ship with a world class DI tool, Bluefish444’s own Symmetry application. The Create range will 

provide an IO solution for the most demanding video professional’s requirements. 

 

AVID certified Bluefish444 hardware 
Create|3D Ultra  Epoch | 4K Neutron    Epoch | 4K Neutron Turbo 

Create|3D   Epoch | 4K Supernova S+ Epoch | 4K Supernova S+ Turbo  

Create|HD   Epoch | 4K Supernova  Epoch | 4K Supernova  

Epoch | Neutron    
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Support and Downloads 
Bluefish444 have a dedicated page for AVID users to find information on support, driver downloads, 

user documentation, Bluefish444 and AVID workflows 

http://www.bluefish444.com/avid/ 

 

Installation guide 
Bluefish444 has now included the AVID certified OPEN IO Plug-in via our driver installation package 

enabling support for Media Composer 6 onwards, and Avid Pro Tools 11 onwards. 

For the latest installer please refer to the Bluefish444 website 

 http://www.bluefish444.com/avid/ 

 

Included in this installer package: 
 Bluefish444 Driver 

 Firmware updater 

 Bluefish444 feature application 

 ASIO audio drivers 

 3rd party application Plug-ins 

 RS422 port to virtual Serial port driver 

 Symmetry Software

http://www.bluefish444.com/avid/
http://www.bluefish444.com/avid/
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Table 1a 

 

The above table show the available video modes with Bluefish444 video hardware 

  

 
4:2:2 YUV 
8-bit 

4:2:2 YUV 
10-bit 

4:4:4 RGB 
8-bit 

4:4:4 RGB 
10-bit 

SD(625/525) 
@25, 29.97fps 

 4K Supernova 
 4K Neutron 
Neutron 

 4K Supernova 
 4K Neutron 
 Neutron 

 4K Supernova 
 4K Neutron 
 Neutron 

 4K Supernova 
 4K Neutron 
 Neutron 

HD 720P 
@23, 25, 50, 59, 60fps 

 4K Supernova 
 4K Neutron 
 Neutron 

 4K Supernova 
 4K Neutron 
 Neutron 

  

HD 1080i 
@25, 29, 30fps 

 4K Supernova 
 4K Neutron 
 Neutron 

 4K Supernova 
 4K Neutron 
 Neutron 

 4K Supernova 
 4K Neutron 
 Neutron 

 4K Supernova 
 4K Neutron 
 Neutron 

HD1080PsF 
@23, 24, 25, 29, 30 fps 

 4K Supernova 
 4K Neutron 
 Neutron 

 4K Supernova 
 4K Neutron 
 Neutron 

 4K Supernova 
 4K Neutron 
 Neutron 

 4K Supernova 
 4K Neutron 

HD 1080P 
@23, 24, 25, 29, 30fps 

 4K Supernova 
 4K Neutron 
 Neutron 

 4K Supernova 
 4K Neutron 
 Neutron 

 4K Supernova 
 4K Neutron 
 Neutron 

 4K Supernova 
 4K Neutron 
 Neutron 

HD 1080P 
@48, 50, 59, 60fps 

 4K Supernova 
 4K Neutron 

 4K Supernova 
 4K Neutron 

  

2Kx1080P/PsF 
@23, 24, 25, 29, 30fps 

 4K Supernova 
 4K Neutron 
 Neutron 

 4K Supernova 
 4K Neutron 
 Neutron 

 4K Supernova 
 4K Neutron 

 4K Supernova 
 4K Neutron 

2Kx1080P 
@48, 50, 59, 60fps 

 4K Supernova 
 4K Neutron 

 4K Supernova 
 4K Neutron   

UHD & 4K P 
@23, 24, 25fps 

 4K Supernova 
 4K Neutron 

 4K Supernova 
 4K Neutron 

4K Supernova 
4K Neutron Turbo 

4K Supernova Turbo 
4K Neutron Turbo 

UHD & 4K P 
@ 29, 30fps 

 4K Supernova 
 4K Neutron 

 4K Supernova 
 4K Neutron 

2 x  4K Supernova 
4K Neutron Turbo 

4K Supernova Turbo 
4K Neutron Turbo 

UHD & 4K P 
@ 48, 50, 59, 60fps 

4K Supernova Turbo 
4K Neutron Turbo 

4K Supernova Turbo 
4K Neutron Turbo   
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Steps to install Bluefish444 driver package for use with AVID software 
1. Install AVID software and 3rd party applications as required. 

2. Physically install the Bluefish444 HD-SDI IO hardware in the recommended PCI express slot 

refer to the hardware user manual for details on physical card installation. The Bluefish444 

user manual can be downloaded from the Manual section of the Bluefish444 website. 

http://www.bluefish444.com/support/downloads/ 

3. Download, save, and run the current bluefish444 retail installer package, available at the 

download section of the Bluefish444 website. 

http://www.bluefish444.com/support/downloads/ 

4. The Bluefish444 installer package may request that you update your hardware to the latest 

firmware. Bluefish444 recommend running the firmware included in the latest installer for 

use with all 3rd party applications. 

Your Bluefish444 hardware should now be installed and ready for use with supported AVID software 

products. 

*If the appropriate Plug-ins for your application has not been installed for any reason, or if any application does not detect the Bluefish444 

hardware. Please uninstall the driver package through the Windows Control Panel > Uninstall. Restart the workstation and run the install 

package again. 

For additional support when using Bluefish444 hardware with AVID software packages refer to the last page of this document for a 

localised support contact. 

Using Bluefish444 hardware with AVID Media Composer software 
Bluefish444 have developed an Open IO plug-in compatible with Media Composer 6.x, Symphony 

6.x, and News Cutter 10.x and onwards. 

The Open IO Plug-in exists only once for all AVID supported applications, and enables similar 

functionality across applications. This document shows how to configure and use Bluefish444 

hardware within AVID applications and is demonstrated with Media Composer v6.5. 

On starting AVID Media Composer, or supported AVID application, the Bluefish444 control panel 

should be accessed in order to set up the Bluefish444 hardware for the specific user environment. 

The Bluefish444 control panel can be accessed from the following sections of Media Composer: 

 Tools > Hardware Setup. 

 Main BIN > Settings > Video Input or Video Output  

 Main BIN > Settings > Audio Project > Hardware > Control panel symbol  

 Tools > Capture Tool > Control panel symbol  

*If the Bluefish444 Control panel is not available through the above options, confirm that the Bluefish444 control panel has been installed 

(c:\Program Files\Bluefish444\BlueFishControlPanel.exe). If required follow the installation instructions above to correctly install the 

Bluefish444 installer package. 

 

  

http://www.bluefish444.com/support/downloads/
http://www.bluefish444.com/support/downloads/
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Machine Control configurations 
Media Composer allows Video Recorders to be controlled via RS42. On Windows the Bluefish444 

RS422 port is assigned as a COM port by the Bluefish444 driver so that Avid Media Composer can 

access it. On MAC OSX a third part USB to RS422 adapter is required. 

To correctly identify the Bluefish444 RS422 port, go to Computer Management and select Device 

Manager. Select ports (COM & LPT) and find the corresponding Bluefish444 RS422 port where you 

will find the COM port number enclosed in brackets. 

See reference image below: 

 

 

 

 

 

 

 

 

 

 

 

You can assign the Bluefish444 RS422 port by selecting Deck Configuration within AVID Settings 

then choose the appropriate serial (COM) port that has been mapped to the Bluefish444 RS422 port.  
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Bluefish444 AVID Control Panel settings: 
 

 

 

  

Video Input Shows the current input signal, resolution scaling options, SDI input A/B selection, 

reference source and type, and the colour space conversion options 

Video Output Shows the current output video mode and pixel format, the prefered 

progressive HD-SDI transport (P / PsF), the colour space conversion,  the video output 

conversion between SD and HD video,  and the 4K Output Mode (2SI, or Auto Quadrant) 

*Note that 2SI is required to monitor 4K HDMI signals 
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Audio Input Show the selected audio source (AES/SDI embedded) 

 

Audio Output Show the current AES audio mapping (outputs 1 to 8), and the analog audio 

mapping (outputs 1 and 2) 



BLUEFISH444 HD-SDI SUPPORT 

9 

23 December 2015 

Bluefish444 in the Timeline 
While working in the AVID Media Composer timeline you are able to adjust the quality that both 

Media Composer and the configured Bluefish444 hardware are working in. 

 

 

 

 

 

 

Media Composer makes the following quality options available: 

 

    Draft Quality setting is used to allow more real time functionality within AVID Media 

Composer. This is achieved through the processing of only ¼ of each video frame. When draft quality 

is selected Bluefish444’s unique hardware scaling technology will take effect, scaling the ¼ 

resolution frames into the full resolution frames of the current project size. 

*Bluefish444 hardware scaling is required for this option. 

    Full Quality setting makes Media Composer render each frame in 8bit video, irrelevant of the 

source footage bit depth. Bluefish444 hardware will read the 8bit video frames then process the 

frames in the 12bit video pipeline. 

    Full Quality 10bit setting makes Media Composer render each frame in full 10bit video, 

irrelevant of the source footages bit depth. Bluefish444 hardware will read the 10bit video frames 

then process the frames in the 12bit video pipeline. 

Media Composer Multi-cam sequences: 
Bluefish444 hardware scaling technology allows users to take advantage of Avid Media Composers 

powerful Multi-cam editing mode. 

While working in Multi-cam mode the Media Composer sequence will always be in Draft Quality, 

using the Bluefish444 Hardware scalers to return the ¼ resolution image to the projects native 

resolution. 

    Draft Quality setting is used to allow more real time functionality within AVID Media 

Composer. This is achieved through the processing of only ¼ of each video frame. When draft quality 

is selected Bluefish444’s unique hardware scaling technology will take effect, scaling the ¼ 

resolution frames into the full resolution frames of the current project size. 

*Bluefish444 hardware scaling is required for this option. 

 

The Media Composer Timeline quality settings 
can be changed through this dialogue 
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Capturing video with Bluefish444 hardware 
Bluefish444 hardware can be configured to capture material directly into AVID software packages 

utilising all the available AVID video CODECS. After configuring the SDI input in the Bluefish444 

control panel and feeding the Bluefish444 hardware with a valid SDI signal the capture tool should 

be opened from the Tools menu(Ctrl+7).  

 

 

 

Select Bluefish as the Video and Audio source. 

 

 

 

Enable the desired Video and Audio channels to 

be captured, and select the video format to be 

captured. 
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AVID Audio Punch In 
Bluefish444 hardware is able to support Audio Punch In allowing playback of video and audio from 

the AVID timeline while capturing an audio source simultaneously. Bluefish444 hardware supports 

the Input of SDI embedded audio and AES audio for capture and audio punch in. 

*Note that in order to capture AES audio a valid SDI signal must be present, house Black or Colour Bars will suffice. 

The Audio Punch In tool can be opened from the Tools menu. 

 

Select Bluefish as the Input Source, the SDI/AES Audio source is set by the Audio Input Tab within the 

Bluefish Control Panel. 
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Using Bluefish444 hardware with AVID Pro Tools 
Bluefish444 have developed an Open IO plug-in compatible with AVID Pro Tools 11 onwards. 

The Open IO Plug-in exists only once for all AVID supported applications, and enables similar 

functionality across applications. This document shows how to configure and use Bluefish444 

hardware within AVID applications and is demonstrated with AVID Pro Tools 11. 

On starting AVID Pro Tools the Bluefish444 control panel should be accessed in order to set up the 

Bluefish444 hardware for the specific user environment. 

The Bluefish444 control panel can be accessed from the Video Track I/O section of Pro Tools. 
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Bluefish444 Epoch|4K Supernova connectors 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Epoch 4K supernova supports many video modes, signal types and frame rates. 

To understand the capabilities of the hardware and each 3G HDSDI connector please refer to Table 1b. 

  

Connector Quad In Quad Out 2 In 2 Out 

1 Input A Output A Output A 

2 Input B Output B Input A 

3 Input C Output C Output B 

4 Input D Output D Input B 

5 NA Genlock  Genlock  
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Bluefish444 Epoch | 4K Supernova card setup (Quad Out) 

AVID Media Composer supports Epoch | 4K Supernova supporting up to 4K 30fps via Quad Link 1.5G SDI 

AVID Media Composer supports Epoch | 4K Supernova Turbo up to 4K 60fps via Quad Link 3G SDI Level A/B 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SDI connector card 1 SDI connector Card 2 

Video Mode SDI 1 SDI 2 SDI 3 SDI 4 SDI 1 SDI 2 SDI 3 SDI 4 

4K Supernova 
        SD 270M 

       

HD/2K YUV 1.5G 1.5G 
   

    HD/2K YUV 3G 3G Level A/B   
      

HD/2K RGB 1.5G 1.5G Link A 1.5G Link B 
  

    HD/2K RGB 3G 3G Level A/B   
      

4K YUV 1.5G 1.5G quad 1 1.5G quad 2 1.5G quad 3 1.5G quad 4 
    

 
    

    4K Supernova 
Turbo         

SD 270M 
       

HD/2K YUV 1.5G 1.5G 
       

HD/2K YUV 3G 3G Level A/B 
       

HD/2K RGB 1.5G 1.5G Link A 1.5G Link B 
      

HD/2K RGB 3G 3G Level A/B 
       

4K YUV 1.5G 1.5G quad 1   1.5G quad 2   1.5G quad 3   1.5G quad 4   

4K RGB 3G 3G A/B quad 1   3G A/B quad 2   3G A/B quad 3   3G A/B quad 4   

4K YUV 3G 3G A/B quad 1   3G A/B quad 2   3G A/B quad 3   3G A/B quad 4   
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Bluefish444 Epoch | 4K Supernova card setup (2 In 2 Out) 

AVID Media Composer supports Epoch | 4K Supernova supporting up to 4K 30fps via Quad Link 1.5G SDI 

AVID Media Composer supports Epoch | 4K Supernova Turbo up to 4K 60fps via Quad Link 3G SDI Level A/B 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

SDI connector card 1 SDI connector Card 2 

Video Mode SDI 1 SDI 2 SDI 3 SDI 4 SDI 1 SDI 2 SDI 3 SDI 4 

4K Supernova                 

SD 270M  270M Input A    270M Input B         

HD/2K YUV 1.5G 1.5G  1.5G Input A    1.5G Input B         

HD/2K YUV 3G 3G Level A/B  3G Input A    3G Input B         

HD/2K RGB 1.5G 1.5G Link A 
 

 1.5G Link B 
 

        

HD/2K RGB 3G 3G Level A/B  3G Input A    3G Input B         

         

4K Supernova 
Turbo 

                

SD 270M  270M Input A    270M Input B         

HD/2K YUV 1.5G 1.5G  1.5G Input A    1.5G Input B         

HD/2K YUV 3G 3G Level A/B  3G Input A    3G Input B         

HD/2K RGB 1.5G 1.5G Link A 
 

 1.5G Link B 
 

        

HD/2K RGB 3G 3G Level A/B  3G Input A    3G Input B         

4K YUV 1.5G 1.5G quad 1 
 

1.5G quad 2 
 

1.5G quad 3 
 

1.5G quad 4   

4K RGB 3G 3G A/B quad 1 
 

3G A/B quad 2 
 

3G A/B quad 3 
 

3G A/B quad 4 
 

4K YUV 3G 3G A/B quad 1 
 

3G A/B quad 2 
 

3G A/B quad 3 
 

3G A/B quad 4   
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Bluefish444 Epoch | 4K Supernova S+ connectors 
 

 

 

 

 

 

 

 

 

 

 

 

 

Epoch | 4K Supernova S+ supports many video modes, signal types and frame rates. 

To understand the capabilities of the hardware and each 3G HD-SDI connector please refer to Table 1b. 

Epoch | 4K Supernova S+ Supports BF Lock generation on BNC 1. When Configuring 4K Modes with Epoch | 4K Supernova S+ Turbo BF Lock will be enabled on BNC 1 and 

should be connected to the Genlock input, BNC 6, of the second bluefish444 card. This will allow card synchronisation for Quad Link across two cards.  

Connector Quad In Quad Out 2 In 2 Out 

1 NA 
Copy A / 
BF Lock Out 

Copy A / 
BF Lock Out 

2 Input A Output A Output A 

3 Input B Output B Input A 

4 Input C Output C Output B 

5 Input D Output D Input B 

6 NA Genlock  Genlock  
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Bluefish444 Epoch | 4K Supernova S+ card setup (Quad Out) 

AVID Media Composer supports Epoch | 4K Supernova S+ up to 4K 30fps via Quad Link 1.5G SDI 

AVID Media Composer supports Epoch | 4K Supernova S+ Turbo up to 4K 60fps via Quad Link 3G SDI Level A/B 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SDI connector card 1 SDI connector Card 2 

Video Mode SDI 2 SDI 3 SDI 4 SDI 5 SDI 2 SDI 3 SDI 4 SDI 5 

4K Supernova S+                 

SD 270M               

HD/2K YUV 1.5G 1.5G               

HD/2K YUV 3G 3G Level A/B               

HD/2K RGB 1.5G 1.5G Link A 1.5G Link B             

HD/2K RGB 3G 3G Level A/B               

4K YUV 1.5G 1.5G quad 1 1.5G quad 2 1.5G quad 3 1.5G quad 4         

 
    

        

4K Supernova S+ 
Turbo 

                

SD 270M               

HD/2K YUV 1.5G 1.5G               

HD/2K YUV 3G 3G Level A/B               

HD/2K RGB 1.5G 1.5G Link A 1.5G Link B             

HD/2K RGB 3G 3G Level A/B               

4K YUV 1.5G 1.5G quad 1   1.5G quad 2   1.5G quad 3   1.5G quad 4   

4K RGB 3G 3G A/B quad 1   3G A/B quad 2   3G A/B quad 3   3G A/B quad 4   

4K YUV 3G 3G A/B quad 1   3G A/B quad 2   3G A/B quad 3   3G A/B quad 4   
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Bluefish444 Epoch | 4K Supernova S+ card setup (2 In 2 Out) 

AVID Media Composer supports Epoch | 4K Supernova S+ up to 4K 30fps via Quad Link 1.5G SDI 

AVID Media Composer supports Epoch | 4K Supernova S+ Turbo up to 4K 60fps via Quad Link 3G SDI Level A/B 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

SDI connector card 1 SDI connector Card 2 

Video Mode SDI 2 SDI 3 SDI 4 SDI 5 SDI 2 SDI 3 SDI 4 SDI 5 

4K Supernova S+                 

SD 270M  270M Input A    270M Input B         

HD/2K YUV 1.5G 1.5G  1.5G Input A    1.5G Input B         

HD/2K YUV 3G 3G Level A/B  3G Input A    3G Input B         

HD/2K RGB 1.5G 1.5G Link A 1.5G Link A Input  1.5G Link B 1.5G Link B Input         

HD/2K RGB 3G 3G Level A/B  3G Input A    3G Input B         

 
        

4K Supernova S+ 
Turbo 

                

SD 270M  270M Input A    270M Input B         

HD/2K YUV 1.5G 1.5G  1.5G Input A    1.5G Input B         

HD/2K YUV 3G 3G Level A/B  3G Input A    3G Input B         

HD/2K RGB 1.5G 1.5G Link A 
 

 1.5G Link B 
 

        

HD/2K RGB 3G 3G Level A/B  3G Input A    3G Input B         

4K YUV 1.5G 1.5G quad 1 
 

1.5G quad 2 
 

1.5G quad 3 
 

1.5G quad 4 
 

4K RGB 3G 3G A/B quad 1 
 

3G A/B quad 2 
 

3G A/B quad 3 
 

3G A/B quad 4 
 

4K YUV 3G 3G A/B quad 1 
 

3G A/B quad 2 
 

3G A/B quad 3 
 

3G A/B quad 4 
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Genlock and BF Lock 
 

Epoch | 4K Supernova S+ cards allow for the generation of a proprietary sync signal, BF Lock, which can be fed into any Bluefish444 Genlock Input. When a 

BF Lock output is connected to the Genlock input of another Bluefish444 card you are able to share a common clock, or synchronisation between the two 

cards. Epoch | 4K Supernova S+ Turbo bundles should have this connection when operating in 4K video modes. 
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Bluefish444 Epoch | 4K Neutron connectors 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Epoch | 4K Neutron supports many video modes, signal types and frame rates. 

To understand the capabilities of the hardware and each 3G HD-SDI connector please refer to Table 1b. 

  

Connector Three In Three Out 1 In 2 Out 

MDR20 
Breakout 

Connector 
   

HDMI NA HDMI out HDMI out 

1 Input A Output A Output A 

2 Input B Output B Input A 

3 Input C 
Genlock / 
Output C 

Genlock / 
Output B 
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Bluefish444 Epoch | 4K Neutron card setup (3 Out) 

AVID Media Composer supports Epoch | 4K Neutron up to 4K 30fps via Dual Link 3G Level B. 

AVID Media Composer supports Epoch | 4K Neutron Turbo up to 4K 60fps via Quad Link 3G Level A. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Video Mode SDI 1 SDI 2 SDI 3 SDI 1 SDI 2 SDI 3 

4K Neutron             

SD 270M           

HD/2K YUV 1.5G 1.5G           

HD/2K YUV 3G 3G Level A/B           

HD/2K RGB 1.5G 1.5G Link A 1.5G Link B         

HD/2K RGB 3G 3G Level A/B           

4K YUV 3G (DS) 3G quad 1 & 2 3G quad 3 & 4 
 

      

 
   

      

4K Neutron Turbo             

SD 270M           

HD/2K YUV 1.5G 1.5G           

HD/2K YUV 3G 3G Level A/B           

HD/2K RGB 1.5G 1.5G Link A 1.5G Link B         

HD/2K RGB 3G 3G Level A/B           

4K YUV 1.5G 1.5G quad 1  1.5G quad 2 
 

1.5G quad 3 1.5G quad 4  
 

4K RGB 3G 3G A/B quad 1  3G A/B quad 2 
 

3G A/B quad 3  3G A/B quad 4 
 

4K YUV 3G 3G A/B quad 1  3G A/B quad 2 
 

3G A/B quad 3  3G A/B quad 4 
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Auxiliary Genlock and Interlock connections 
 

Neutron cards feature an additional Auxiliary Genlock connector located internally on the top edge of the card. The Auxiliary Genlock input connects to the 

MDR20 Breakout. 

 

 

 

 

 

 

 

 

 

 

 

Multiple Neutron cards may be locked together sharing a common clock. This is achieved by attaching the Interlock cable (Part Number CAB_ILOK) from the 

Interlock Output of one card to the Interlock Input of a second card.  
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Bluefish444 SDI Signal types and SDI Transport types 
The table below shows the types of video signal that can be transported on various SDI types and how many cables might be required. 

SDI Signal Type SDI Transport Type 

TYPE Frequency FPS Resolution Sampling Colour Space 270M 1.5G 3G Level A 3G Level B 
3G Level B  

DS 

SD @25, 29.97 625/525 422 YUV 1     

SD @25, 29.97 625/525 444 RGB 2     

HD 720 P @23, 25, 50, 59, 60 1280x720 422 YUV  1    

HD 1080 i @25, 29, 30 1920x1080 422 YUV  1    

HD 1080 i @25, 29, 30 1920x1080 444 RGB  2 1 1  

HD 1080 P/PsF @23, 24, 25, 29, 30 1920x1080 422 YUV  1    

HD 1080 P/PsF @23, 24, 25, 29, 30 1920x1080 444 RGB  2 1 1  

HD 1080 P @ 48, 50, 59, 60 2048x1080 422 YUV  1 1 1  

2Kx1080 P/PsF @23, 24, 25, 29, 30 2048x1080 422 YUV  1    

2Kx1080 P/PsF @23, 24, 25, 29, 30 2048x1080 444 RGB  2 1 1  

2Kx1080 P/PsF @48, 50, 59, 60 2048x1080 422 YUV  2 1 1  

UHD 1.77:1 P/PsF @23, 24, 25, 29, 30 3840x2160 422 YUV  4   2 

UHD 1.77:1 P/PsF @23, 24, 25, 29, 30 3840x2160 444 RGB  8 4 4  

UHD 1.77:1 P/PsF @48, 50, 59, 60 3840x2160 422 YUV  8 4 4  

UHD 1.89:1 P @23, 24, 25, 29, 30 4096x2160 422 YUV  4   2 

UHD 1.89:1 P @23, 24, 25, 29, 30 4096x2160 444 RGB  8 4 4  

UHD 1.89:1 P @48, 50, 59, 60 4096x2160 422 YUV  8 4 4  

Table 1b 
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Bluefish444 AVID support 

General Information 
Bluefish444 host a dedicated AVID webpage. Here you can find information on the latest supported 

features and hardware, along with installer updates and support contacts. 

www.bluefish444.com/avid 

 

Contacting Support 
Bluefish444 provide unlimited email and phone support to all registered customers for the life of the 

product warranty. 

If you have any questions please contact support at: 

avid.support@bluefish444.com 

support@bluefish444europe.com 

For telephone support you must register your product at 

www.bluefish444.com/support/techsupport 

To help our representatives resolve your issues please have the following information on hand: 

 System configuration and manufacture, motherboard type and devices installed 

 SCSI or RAID controller card type as well as storage array configuration 

 Operating System, and Version 

 Applications installed, and Version 

 Bluefish444 Serial number and product type 

 Bluefish444 Installer version 

 Contact number 

 Company name 

All AVID customers may use the Community Forums and Avid Knowledgebase for free. 

(http://community.avid.com/forums/ and http://www.avid.com/US/support/find-

support/category/knowledge-base, respectively) 
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